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read the free preview pages 736 to 743 not shown in this preview. 1. Guide Básico de MicroStation V8Bentley Systems IbéricaDepartamento de Formación 2. The government's policy of taking into consideration is a major challenge for the Government of The United States of America. New practices
arising from practices arising under new practices (EMERGENTESHERRAMIENTAS DE SELECCIÓnRAMIENTAS DE DIBUJOTEXTOS) ESTRUCTURA DE DIRECTORIOSLa estructura de directorios de V8 facilita las actualizaciones y reduce la probabilidad de sobrescribirdatos al volver a instalar
MicroStationEl directorio Home La carpet A BentleyHome proporciona una ubicación de almacenamiento local para determinados datosde productos de Bentley específicos de equip uno o estación de trabajo. La ubicación de esta carpeta sedefine mediante la variable _USTN_HOMEROOT (por defecto,
se encuentra en el mismo nivel que. programme.. working space.. documents). Los archivos de preferencias de usuario y dfltuser.cfg, el archivo que contiene el nombre del espacio detrabajo actual, se crean y se almacenan por defecto en la carpeta BentleyHomeprefs.... El directorio documents Este
directorio contiene los nuevos ficheros de documentación de los productos. Nombre deldirectorioDescripciónBentleyDocumentation Contiene todos los ficheros de documentaciónde idioma y del programaEl directorio ProgramEste directorio contiene los archivos necesarios para que MicroStation pueda
funcionarcon Default settings. The files installed in this directory include license files, MicroStation system files, and MicroStation system files, if engineering configuration system files such as executable files are installed in illustrations, forms, or TriForma. 4.
BentleyProgramStationstationstationconfigdatabasedocscjmlmddappsmdlsystemp Workspace Directory Workspace Guide is where users create and maintain standards and projects in a network environment. User data files must be stored in a workspace manual or in a shared network in order to share
project data, develop, maintain, and enforce the use of graphic and microStation standards on the desktop. Within the workspace guide: • Project Guide: Where project data is usually stored.• Metrics guide: Cad administrator or system administrator stores and maintains company standards. Project data
that can be used in multiple projects can be transferred to this guide.• System Directory: Updated by Bentley, user data placed in this directory will be overwritten through software updates or subsequent installations. The directory structure of project sample projects must be created in the project
workspaces directory. MicroStation provides a set of model projects in the project workspaces directory that users can create projects using their own rules to choose names. These files can be installed anywhere on the network by setting the root of the system _ustn_workspace before microStation
starts. 5. BentleyDefectoValueWorkCeointerfacesValue by defectofkeysMicroStation virtual menu key value default value of euroosprojectsValueprovidedandambassador of recurosProjectsValue by virtual orcssociological valueprocess and ararchivesarchicalBordersBordersBords Files unspecified
deningunaaplicationCivilSubdirectives, general civil files, generalfilesMappingSubdirectives and ararchives of mechanical labels, designs, engineering instructions, files ofvisualstructuresSubdirectives and files of visualualationuntitledThe seed project to be copied gnlib project without 6. Address Libraries
decellesdataProject sintitulo data filesdgnProject sinttulo filesDGGoutProject sinttulo directory project syntitle filessemillasymbProject filessemillaStandardsCompany Standards (joint ventures) dgnlibLibrarys decellaries of the company (joint venture) dataFiles datafiles of the company standards data (joint
ventures) dgnFiles dgngn company standards (joint-project) macrosCompany standards (joint-project) materialscompany standards (joint projects) mdlappsmddapps destandards of the company (joint projects) plotdriversController files 7. The company's standard plotter (joint ventures) files classified for
company standards (joint venture) SPCDefect site of configuration variables, security and company file additives (joint-project) tablesFiles from the company standards tables (joint projects) VBAFiles of BasicVisualSystem nocolocar user data standards in this guide.dgnlib Bentley's main principles,
noonlocate user data in these directory.dataBentley states, nocolocate user data in cases of this directory.imageBentley, nocolocate user data in these directory.macrosBentley states, there is no user data in this directory form.bumpsstandards, or no allocation User data in this directory. 8. Bentley
standards lists, noplace user data in thisdirectory.plotdriversBentley standards, nocolocar user data in this guide.seedStandares deBentley, nocolocar deuser data in thisdirectory.symbStandares deBentley, nocolocar deuser data in this guide tables.tablesStandares deBentley, do not put user data in this.
Bentley standards, nocolocate user data in this guide. Removed in V8. VBAVisual BasicUsersFilesuser 9 configuration files. You can start a start of the type of 10000000000000000000000 0000 000 000 000 000 000 000 000 000 000 000 000 000 000 000 000 000 000 000 000 in the MicroStation
program group, double-click the code in Windows Explorer, double-click the DGN file code (with extension .dgn). Drag the DGN file icon from Windows Explorer and drag it to the Windows MicroStation icon. In, double-click the ustation file icon.exe. Work with DGN filesA MicroStation document file called
DGN file. The DGN file consists of one or more forms, and each model is represented by elements such as lines, arcs, and polygonal shapes. The MicroStation File menu contains options for creating, opening, and saving DGN files. These and other file management processes can also be performed
using the MicroStation Management Dialog. 10. You can't have more than one DGN file open on MicroStation Time. If you open an ADGN file when you open another file, MicroStation automatically closes the first. However, you can view the forms included in other DGN files by linking them as a
reference to the active form of the open DGN file. When you create a DGN file, MicroStation copies a DGN template or its classified files. The seed file is copied to a new file named in the new dialog box. Using MicroStation ManagerW When MicroStation starts without setting the DGN file to open
automatically, the first dialog box that appears is MicroStation Manager.You can use MicroStation to perform a variety of file management functions, such as backing, copying, deleting, compressing, merging, renaming and opening design files. These features can be implemented by selecting items from
directory menus and a file in MicroStation Manager, where you'll find features that go beyond those included in other dialog boxes. MicroStation Manager is also used to determine the components of the workspace. A workspace is a custom MicroStation environment or configuration. To create a new
DGN file with microStation1 manager. In the file menu in MicroStation Manager, choose the New.The New dialog box. This is the same as the 11th dialog box. Which is used to create a new DGN file on MicroStation when you choose a new menu file. To back up a file with microStation1 manager. In the



MicroStation Management Files menu box, select file.2. In the file menu in MicroStation Manager, choose the Copy.The dialog box that copies a file that appears. The file name selected in the field will appear from:&lt;nombre_archivo&gt;and the .bak field will appear in field A: field.3. Click OK to back up
the file as nombre_archivo&gt;.bak. The file will be backed up, the dialog box closes, copies the file, and the selected file remains selected to open the MicroStation Manager box. To open a copy of a file using MicroStation1 Manager. In the MicroStation Management Files menu box, select file.2. In the
file menu in MicroStation Manager, choose the Copy.The dialog box that copies a file that appears. The file name selected in the field will appear from:&lt;nombre_archivo&gt;and the .bak field will appear in field A: field.3. Edit the file name in field A: And change the extension .bak by any (for example,
.dgn). A copy of the file will be made nombre_archivo &gt;&lt;/nombre_archivo&gt;/nombre_archivo&gt;Close the file copy dialog box and the selected file copy will be selected to open in the MicroStation box administrator file list. To rename a file with microStation1 manager. In the MicroStation
Management Files menu box, select file.2. In the file menu in MicroStation Manager, choose rename. The name of the selected file appears in the field from: Field A appears blank.3 Enter a file name in field A: . MicroStation management does not automatically add .dgn to the file name. If the filter is set
to *.dgn and the new file name does not end in dgn, the new file name will not appear automatically in the file list box in MyStation.4 management. Click OK. The file will be renamed, the RenameFile dialog box is closed, and the recently renamed file will follow 12. Select to open in the MicroStation box
manager file list. To delete a file using microStation1 manager. In the MicroStation Management Files menu box, select file.2. In the file menu in MicroStation Manager, choose Delete.An the alert box shows the path, name of the selected file, and a prompt to confirm the deletion.3 Click OK to delete the
file. To compress a file using microStation1 manager. In the MicroStation Management Files menu box, select file.2. From the file menu in MicroStation Manager, choose Comprimir.Se the selected file will be compressed. To create a new subdirectory with microStation1 manager. In the MicroStation
Manager Director's list, choose Nuevo.Se open the dialog box to create the directory.2. In the Dir field: Enter a valid subcode name.3. Click OK. The new subdirectory is created and appears in the box directories list. To copy DGN files from a manual to a new directory using the MyStation1 administrator.
(Optional) set menu files from type to *.* or with another appropriate filter as long as any of the files that are copied end up in .dgn. In the directory menu from the MicroStation manager, choose the Copy.The dialog box that copies the directory shows. In the Dir field: The current work guide and path will
appear. In the Dir field: Edit the path and directory field.4. Click OK. Files whose accessory matches the filter will be copied to the specific directory. If it's There is no microStation administrator and errors will be reported when the files are copied. To compress all design files in directory1. Use the
MicroStation Management Directories menu box to select the desired directory or choose a directory from the directory menu. 13. 2. Set the appropriate filter value to the file list from type.3. From the MicroStation Manager Guide menu choose Compression.4. In the alert box that appears, click OK. All
chart files that match the filter will be compressed. Integrating DGN files merge simulating is basically (but not only) the process of copying all forms from one or more DGN files (file (file (source) to another file (destination file). (Optional) uses &lt;Ctrl y= haga= clic=&gt;to identify more source files.5 The
files will appear in the file list.6. Click the OK button. Close the file selection dialog box and the active window merge dialog box becomes back, where the selected files will be displayed in the file list box to merge.7. In the Merge-to section, click the button. In the menu box, select the target.9 file. Click OK.
The dialog box selects the target file to close, and the merge dialog box becomes the active window again.10 Clicking the button Fusionar.Al merge to close the merge dialog box, and the MicroStation administrator will be active again. 14. To run the merge of the system command line1. In the system
prompt, enter: msbatch merge &lt;archivo_destino &gt; &lt;archivo_origen_1&gt;... &lt;archivo_origen_n&gt;[Example: msbatch merge destination.dgn source1.dgnsource3.dgnBeasure from MicroStationWhile while working MicroStation Saves all the changes you make to the open DGN file (assuming you
did not disable saving design changes immediately to workspace &gt; To operations archivo_destino archivo_origen_1 archivo_origen_n).You don't want to stay before you leave MicroStation1. In the file menu, choose Exit.or from the app window menu (if any), choose Close., or in the MicroStation
Manager Dialog box, click the Cancel.MicroStation button and enter the graphics. Mouse buttons or a digital table are set to send different types of duetographic input to MicroStation. These appointments are called microStation buttonbuttons. For example, the button assigned as the MicroStation Data
button sends an entry type that receives the data point name to MicroStation when you press it. Reset the button if you use the dialog button assignments (workspace &gt; button assignments), you can set the following button sets:• One button.• One button modified by the key.• Two buttons press in
&lt;Alt&gt;the same time (mouse only).• Two buttons press at the same time and adjust them with the key &lt;Alt&gt;(mouse only). Default mouse button assignments are as follows: 15. MicroStation button activated by left buttonButtonButtonMajor Button Right Button Reinitialize right button3D data Alt-
Left buttonTentative 3D left button button button rightbuttonThe default settings are suitable for mouse buttons. If you use a mouse with three buttons, you must change Tentative to use one button (more than two buttons) to speed up operations. To reset the buttons on MicroStation1. In the workspace
menu, choose button assignments. The dialog is opened for button assignments.2. In the menu box, select the button that you want to change the assignment you want to change.3 Place the cursor in the area below the menu box where the instructions.4 appear. Click the button or the set of buttons that
you want to set to the selected button. The new button setting appears in the menu box. Using MicrosoftStation's drawing tools, dozens of drawing tools (called tools, for a short time). To facilitate your choice, they are organized into tool boxes. When the toolbox is open on the built-in screen of its frame, it
is said to be floating. You can change the layout of a floating toolbox by resizing its window. In tool boxes, they are represented by icons. To simplicity, the term tool is used to refer to both the tool and its symbol. Toolbox &lt;/Alt&gt;&lt;/Alt&gt;It opens automatically the first time microStation is turned on
with a attribute toolbox, a primary toolbox and a standard toolbox. The main toolbox is installed to the left edge of the MicroStation window by default, and the basic and standard features and tools are installed at the top edge. 16. In the list of tools, the selection marks refer to open tool boxes. Show and
hide toolsYou can selectively turn the tool view on or off in tool boxes. To hide tool 1 or show it. Open the toolbox that contains the tool code.2. Place the cursor inside the toolbox and click the mouse button. A pop-up menu opens. Activated tools are indicated by the markings.3. Choose the pop-up menu
item for the tool you want to hide or show. 17. Check the status barRecommends that you get used to checking frequently the information bar at the bottom of the app window (or screen). View useful information, including claims, messages, and the name of the selected tool. If you're not sure where to use
the tool, check the status bar. The information bar is divided into two parts: the left section of the status bar shows the left section the name of the selected tool (or display control) followed by a symbol larger than (&gt;) and the message text. The text of the message that goes after &gt; is the indicator of
the chosen tool; Tool pointers serve you a manual, step by step, when you perform an operation with a tool. Just to the right of the information bar tools section is the message center window code and message area, which displays different warning notifications and error. Clicking the message center icon
opens the message center window, allowing you to review messages displayed in the information bar. The right section of the status bar usually consists of a series of fields. From left to right, the information on the abolition of the two mandates referred to in these areas is as follows: 18. • Setting
alignment mode.• The lockcode does not indicate status information. Click it to access the sub-lock list from the Settings menu in an alternative way.• Adjust the active level.• The number of items selected. If this field is empty, there are no specific elements.• If the fence is set. If this field is empty, the
fence will not be set.• If the configuration variable It is known as DGN or DWG. If set to DGN, the field is empty. If assigned to DWG, the field will have a cross-white label on a blue background.• Whether the changes made to the open DGN file are unannounced or not. If this field is empty, there are no
non-regenerated changes. If the field is a black floppy disk code, there are unsalted changes in the DGN. If the field displays a red floppy disk code crossed with X, the DGN file is open for read-only access. Keyboard input keyboard input keyboard input is the instructions that the user enters under the
microStation control keyboard input. The effect of almost all keyboard inputs can be achieved using the GUI. However, sometimes keyboard input can be faster, especially since MicroStation recognizes shortcuts. To open the Input1 keyboard window. From the helplist, choose input.or keyboard from the
Help menu, choose the keyboard browser. Enter the keyboard entry to be able to enter the keyboard input, the window keyboard input window entry window must be active. When the keyboard input window is the active window, the flashing text pointer appears in the editing area, and the title bar is
highlighted (if it is visible). 19. MicroStation recognizes the input of the shortcut keyboard. For example, the keyboard entry can be shortened to download MDL&lt;nombre_aplicación&gt; to MDL L&lt;nombre_aplicación&gt;. The abbreviation cannot be impenetrable; To select a tool or display control using
keyboard input1. In the data entry field in the keyboard entry window, type the text you want to enter. While typing, the system matches characters with keywords in the keyboard input command language. When there is a map, the matching keyword is automatically selected in a menu box below the data
entry field.2. If necessary, edit the keyboard entry using the actions described in editing keyboard entries.3 When you're done, click the keyboard button or press &lt;Retorno&gt;. The keyboard entry is an entry. If there is no obvious effect, check for any messages in the information bar. You can also use
localization and create keyboard input boxes in the keyboard input window to search and build keyboard input: to scroll through the first words of keyboard input, select one word, wander through words that can follow the selected word, then select another, and asynchronously. You can then turn on the
keyboard input on the MicroStation.To build keyboard input1. In &lt;/Retorno&gt;&lt;/nombre_aplicación&gt;&nombre_aplicación&gt;In the left corner of the key input window, select a keyword. The selected keyword will appear in the data entry field, and secondary keywords from the second level will be
displayed in the second box of the keyboard entry window.2 As needed, select additional keywords, one for each list box from left to right, until you create an unwanted keyboard input.3 To process the created keyboard input, click the keyboard button or press &lt;Retorno&gt;on . MicrosoftcroStation
buffer keyboard entries recover the implementation of keyboard entries so that they can be recovered and edited if necessary. This function is similar to line editing software from some operating systems. When the buffer is full, if necessary, the older keyboard inputs it contains are sown to provide space
for the latest entries. To recover the keyboard entry1. Press the key frequently until the required input text appears in the data entry field in the keyboard entry window, or in the large keyboard entry history box at the bottom 20 of the keyboard input window, select the unwanted keyboard entry.
Preparations to draw user preferences, there are no default settings in MicroStation. The settings you host in the following subsections to the disk can be saved in the DGN file. To keep the changes made to these settings in the DGN file from one session to another, you must save them automatically.
Seed files When a DGN file is created, a seed file is defined as a template for the DGN file. The new DGN file is actually a copy of the seed file. Basic files do not contain (necessarily) items, but, like other DGN files, they contain a model (by default), settings, and display settings. Avoid having a seeding
file with custom settings having to set the settings every time the DGN file is created. If you wish, you can get a different seed file for each type of drawing you make. MicroStation includes a large number of seed files for specific disciplines, in addition to generic seed files, seed2d.dgn and seed3d.dgn. to
select a seed1 file. In the file menu, choose the New.The New.2 dialog box appears. In the Seed file section, click Selección.Se open the dialog box to select an asset file. The default filter is MicroStation DGN files [*.dgn]. 21. 3. (optional) to insert all autoCAD files or files in the file list box, choose all
&lt;/↑&gt;&lt;/Retorno&gt;[*.*] Or AutoCAD graphic files [*.dwg] in the Type.4 list files list. (optional) to select another source drive, choose from the Drive.5 options list. (Optional) to select a different source guide, use the directories list box.6. In the file list box, select the desired initial file.Or in the file field,
enter the desired initial file name.7 Click OK. DGN design environmentWhen painted in 2D, the design plane is the equivalent, in MicroStation, of drawing paper. However, unlike the drawing sheet, the design level (or 3D cube) of the DGN file is incredibly large, allowing you to draw models on a full scale.
To draw multiple items in the model, you can enter data points. Each data point at the design level has linked positions or coordinates x (horizontal) and y (vertical). Therefore, the design plan is simply the cartesian coordinate system on which the model sits. The coordinates are expressed in figure (X, Y).
In seed files available with microStation's virtual workspace, the so-called global origin point is defined at the center of the design level range and its coordinates 0.0.In most cases, the global source of seed files provided is appropriate. Noobstant, it may be appropriate to change the location or
coordinates of the global origin. For example, an architect may be interested in all coordinates that have positive values. Map or non-opography can use a network system identified by a government agency for all locations to indicate a particular point. For more information, see the global rule
amendment. When you enter a MicroStation data point, save its coordinates in a 64-bit iEEE comphalorant format. The 3D design cube is similar to the 2D design level, but features a Z-axis (depth) landing. Points in 2D forms are stored as formatted format values (X, Y), while points are stored in 3D
forms as (X, Y, Z). Modular work units are real-world units that you work with when you draw or create forms in a DGN file. Work units are usually defined in seed DGN files, where the DGN file is created to work. Typically, no modifications are required. You can choose main units and auxiliary units by
name, such as feet and inches, or counters and gauges. Changing the unit names of the work does not affect the size of the lageometry measurement of the model. In short: • Work units are As main units (the largest units commonly used in design, such as counters) and fractal auxiliary units (the
smallest unit is easier to use, such as centimeters or millimeters). • Units cannot be larger than the main units.• You can change work units without being affected by the size of the design elements. You can draw in meters and centimeters, for example, and then rename it from units to feet and inches for
English measurements. 22. Choose the names of work units 1. From the settings menu, choose the design file. The dialog shows the dGN.2 file settings. In the class list, select work units.3. From the list of key unit options, choose the required units. If you change the main units from metric to English or
vice versa, unitauxiliate will also be changed to a suitable unit. Similarly, if you select a master unit smaller than the current byte unit, the current assistant is changed to an appropriate unit.4 (Optional) from the list of auxiliary unit options, choose the necessary units. Adjusting the resolution within the
settings of an advanced dialog unit is the resolution setting, which determines the resolution of the design level and affects the size of the item in a model. This command can be viewed that consults the system administrator before changing the resolution setting. In the DGN file, the resolution setting is
used to determine the accuracy of the worst state of the design environment, which occurs only at the same edge of the workspace (very wide). For example, when working on a bad case accuracy of 0.0001 meters, the size of the plane or cube design will reach 900 million kilometers along each axis. The
actual resolution is several million times better when drawing near the origin of the design plane, which is the usual situation. Therefore, there is no case in which it is necessary to change resolution.expression from work units when you enter spaces in DGN files that are usually expressed in one of the
following formats: • As a standard decimal number such as 1,275.• As two numbers separated by two points indicating MU:SU. For example, 3:4 indicates that there are three main units (MS) and four auxiliary units (SSS). The following table shows examples of the distances expressed in the last figure.
Mu:Your work units after devices/inches 120:10 3,657.60 ft, 25.40 cm Millas/yards 350:65 350 thousand feet, 65-mile inch/5:25 cm 5.25 cm, 25 cm/micrometer Or: 500 half a mile, the active ORIGIN keyboard entry (GO) is used to determine the global source. This allows you to set the coordinates reading
to 0.0 at any point in the form you filter (with a non-detail point). 23. The reading format is the setting that controls the shape and resolution in which MicroStation displays coordinates, distances, and angles in the status bar and dialog boxes. The definition of reading coordinates does not affect the
accuracy of calculations, only the accuracy with which the results are displayed. To set the reading format1. From the settings menu, choose the design file. The dialog shows the dGN.2 file settings. In the category menu box, select the reading format. Five lists of options for defining reading appear
coordinates.3. From the list of format options in the reading format section, choose key units, auxiliary units, or work units.4 From the list of precision options, choose the number of decimal places (1-6) or fractional eldenominator (2-64) where the fractions of the selected units will appear in the list of
formatting options.5 From the list of formatting options in the corners section, choose GG. GGGG for reading angles in decimal format, or GG MM SS for reading angles in grades, minutes, and seconds.6. From the list of mode options, choose traditional, greatest, or trend.7. From the list of precision
options, choose the number of decimal places (0-8) with which fractional angle measurements will be displayed.8. Click OK. 24. Introduction of precision coordinates by keyboard. Absolute coordinates: XY-xxxxx,yy,zzzzz relative coordinates:DL-xxxxx,yy,zzzzzpolar coordinates:DI-ddd, yaaa* distance and
AngleSaves DGN file settingsKeep changes made to dGN file settings (such as work and reading format units), from one session to another, you should save the settings explicitly. To save the current settings to open the DGN1 file to the disk. From the file menu, select Save Settings. &lt;CTRL-F&gt; 25.
VISUALIZATIONMICROSTATION ENTERPRISE WINDOW DISPLAY DESIGN GIVES YOU THE ABILITY TO HAVE UP TO EIGHT OPEN VIEW WINDOWS AT ANY TIME. Additionally, it allows you to customize the organization of display frames within the application window. To open a window view1.
In the submenu views of the window menu, choose the display window number that you want to open. Sublist activation marks refer to open display window numbers. Alternative method — to open a view window1. From the window menu sub-menu, select &lt;/CTRL-F&gt;View frame groups. By default,
it is automatically installed at the bottom of the window. The numbered buttons that are highlighted represent the number of open views.2. To open a closed view window, click the numbered button. To open or close multiple display frames in the Group View Window1. In the view groups window, click and
drag over multiple view buttons. Wever view opens or closes depends on the status of the first window. For example, if views 3 and 5 are closed and display 4 is already open, clicking the 3 button and dragging the mouse through the dialog from the 3 button to the 5 button will open views 3 and 5 (but the
4 display will not be closed). 26. To close the view window1. In the submenu views of the window menu choose the display window number that you want to close.Either in the window address bar, click the close window button at the far right, or double-click the window menu button on the far left. Window
address bar), Select Close.Alternative Method — to close view window1. In the sub-view menu of the window menu Choose Dialog.The display of window groups appears. By default, it is installed at the bottom of the window. The numbered buttons that are highlighted represent open views.2. To close an
open view window, click the numbered button. To organize open view frames to reduce unused screen space1. In the window menu, choose Arrange.To arrange open view windows in Cascade1. In the window menu, choose an open view window Waterfall.Each is allocated the same amount of screen
space, but only the display window with the lowest full number. Other open view frames are stacked under this display window, making their address bars visible only. To til windows1 open view. In the Window menu, select Tile.Each open window is allocated the same amount of screen space, and
windows are organized by numbers, from bottom to top, starting from the upper left corner of the MicroStation window and advanced from left to right. If the display windows are more than three open, they will be arranged in a lower upper row and a lower description. If the display windows are open on
more than one screen, the display frames will be tiled on each screen on the screen on which they are open. To make a particular view window fully visible without sutamaño or site1. In the window menu, choose the window you want to view. (Open frames are listed at the bottom of the window list.) 27.
To maximize the display window1. Click the Zoom button in the view window Maximize.To. Click the Zoom button in the view window.Or from the display window control menu, choose Minimize.To restore the previous size of the view window1. Click the Zoom or Zoom button in the Restore.To display
window. Hover over the address bar in the view window.2. Hold down the data button.3. Drag the view window to the desired location.4.View GroupA Group View is a collection of display window layouts that can be applied to an open DGN file form. Therefore, viewing groups makes it easy to access and
navigate different models. View groups let you configure a MicroStation session to display view window preferences, including the number of open views, as well as the direction and size of views. It also includes defining a display group that displays the attributes of each view and its level view settings.
With display groups, you can quickly switch from one configuration to another. For example, at some stages of the design process, you may prefer to organize the screen with a display of 1 by an isometric display that takes two-thirds of the screen, while views 2, 3, and 4 share the remaining part of the
screen and display the front, lower and right views correctly. At other stages, you may need to have a single isometric view, which takes full hold of the workspace. When you create an item, you are asked to create a display group associated with this model by activating the creation of a display group in
the dialog to create a form. To create a display group when you do not create form1. Configure display frames using the display window settings you want.2 Under the Group View window, click the view group management icon. The dialog appears to manage display groups. 28. 3. Click the icon to create
a display group. The dialog box shows creating a display group.4. Fill in the name and description fields. The model that is associated with this view set is already listed in the dialog box.5 Click OK. A new display group is created. To change the active view set1. In the list of window options View the
group, select another display group. Or in the view group management dialog box, select the display group, then click an app (or simply double-click the user view group). The screen will be updated to show the new display settings. To modify the view set1. Under the Group View window, click the view
group management icon. The dialog shows the management of display groups.2. Click the property editing icon for the selected display group. The dialog shows showing group properties.3. Make the necessary modifications to the name and description.4 Click OK. To delete the view set1. Under the
Group View window, click the view group management icon. The dialog shows the management of display groups.2. Select the required display group.3. Click the clear view group icon. The privileged display group is deleted. 29. View the control barThe controls are organized in a view in the view control
bar located in the lower left corner of each view window as follows: on the control bar in the view in question, select update (redrawing) one or more views. Update the view in the zoom of a view. Zoom in on the zoom action for an opinion. OutDo zooms in on an area window in a view. The window area is
all visuals for active layout and references related to an opinion. Adjust the Renote view. ViewView rotates a different part of the design without changing the display environment. Panoramic view of the last display. See PreviousRedo's last view. The following view (3D views only) changes the perspective
area in a 3D view way. Change the perspective of view 30. (3D displays only) defining view mode. Set view mode (3D views only) go camera in 3Dactiva view. Change perspective cameraee appendix 2 keyboard input: VIEW ON definition of view attributesSee many attributes that can be individually
modified for each view window.• Some display attribute settings determine whether different parts of &lt;1 |2 == =4= |= 5 = |6 = |=7 =8=&gt;A model that will be displayed: items at specific levels, for example, text, packing, and drawing aids, such as grids.• Others determine how to view the form, with or
without a dynamic background image. (Many of these view attributes are inaccessible in the new user interface for the workspace.) Select and control the display of a background imageYou can select an image in any of theControl whether the image is displayed in the background of each display window.
To select a background image and control its width1. From the settings menu, choose the design file. The dialog shows the dGN.2 file settings. In the category box, select views. 31. In the main section of the dialog, the button and controls for the background of the image appear. Click the background
image button. The dialog box shows the view of the image file.4. Select the desired image file, then click OK. Close the dialog box to view an image file, and the dialog box becomes the active window DGN file settings again.5 For each view window that you want to control the width of the image in which
you select, choose the frame with its number from the menu, view the options and select the Background.6 checkbox. Click OK. Close the dialog box and apply background images to those displayed. Other view attributes are defined as display attributes that are not displayed in the dialog to display
attributes. Some allow you to determine whether parts of the form and graphic aids will be displayed on the screen. Others determine how to view the DGN file. To turn other view attributes on or off1. From the Settings menu, choose The Attributes View (or &lt;CTRL-B&gt;press). The dialog box is opened
to display the attributes. 32. 2. From the number view options menu, choose the view number you want to change their attributes.3 Select or unselect the desired view attributes by clicking check boxes to the left of the matching options.4 Click the button app. To apply the same attributes to all views1.
From the Settings menu, choose The Attributes View (or &lt;CTRL-B&gt;press). The dialog box is opened to display attributes.2. From the list of number view options, choose the view you want to apply to all views.3. (Optional) Select or unselect the desired view attributes by clicking check boxes to the
left of the matching options.4 Click all the button. Using viewsave view is a view definition, which includes form view levels, cutting volume references, and other view attributes. The view definition is given a name and saved in the DGN file. To create the definition, a source view is configured as a plan
and saved. The view saved in the View &lt;/CTRL-B&gt;&lt;/CTRL-B&gt;Destination. The saved views dialog lets you name, save, retrieve, and delete saved views. To name a view and save it1. The source view is configured so that the desired part of the chart is visible, and display attributes are set to
liking.2. In the helptools menu, choose reserved views. Or from the control menu of any view window, choose Save/RecoverViews.The dialog box shows saved views. 33. 3. In the saved view dialog, click the Save view icon (at the far left). The dialog shows the saved view.4. In the name field, enter a
name to see the view. The maximum number of characters in the name is limited to 511. Alphabet and digital characters, plus characters $, and _, are valid. Small characters are interpreted as capital letters.5. (Optional) in the description field, enter the description.6. From the list of views options, choose
the source view number.7. Click OK. To recover a saved view1. In the helplist, choose saved views.or from the control menu of any view window, choose Save/Recover views.The dialog shows saved views.2. From the list of display options, choose the target display number.3. In the menu box, select the
saved view you want to retrieve.4. Click the button app. To delete a reserved view1. In the helplist, choose saved views.or from the control menu of any view window, choose Save/Recover views.The dialog shows saved views.2. In the menu box, select the saved view you want to delete.3 Click the
Delete button. 34. BoxThe standard toolbox contains codes that allow quick access to frequently used drop-down menu items. It is located, by default, at the top of the MicroStation window (just below the menu bar). Selecting this code has the same effect as choosing a new results file list &gt; another
creates fileOpen FileMenu file &gt; open file save file &gt; save the current file openPrintFile &gt; PrintPrints contents of active viewCutMenus model plus &gt; delete item or selected items 35. CopyMenu edit &gt; CopyCopy item or selected itemsUser editing the item &gt; PastePegates item or selected
items deBentley on the website. HelpMenu &gt; Content provides access to keyboard input instructions on the screen: DIALOG TOOLBOX STANDARD [OFF] in Switch36. Toolbox attributes and toolbox features contain drawing tools and controls that are used for frequently used settings. It is located, by
default, at the top of the MicroStation window (just below the menu bar). The attributes toolbox is organized as follows: To UseDefining active level filter. The active level filter, active level values. 37. Active levelActivecolor. ColorDefines active font pattern. The pattern of the active line is in the weight of
the active line. 38. Active line thickness. The active feature class defines the active class of active coding. Enter keyboard preview icons: Attributes to the dialogue toolbox [OFF] in TOGGLE] 39. Color - You can select 255 colors in a color table for each graphic element. The color can be fixed or depends
on the level at which the drawing element is located. Font style - You can select 7 fixed line patterns, so the user can select their font patterns. Line patterns are not subject to text. Also, the font pattern can be repaired or depends on the level at which the drawing element is located. Thickness - There are
32 thicknesses that apply to the drawing element. These thicknesses do not vary depending on the dezoom degree of view. The thickness can be installed on the drawing element or depends on the level. Category - You know the type of drawing element. The following types are found: origin and
construction in attributedialog. There are also dimensional types, pattern components, basic ruler, linear engraving, and construction ruler. These types are created by specific commands and cannot be selected from this option. Sample active icons - preview active icons according to the selected options.
It also indicates the label of color, style, and thickness values. 40. The Basic Toolbox is the basis of the most used microstation tools. The toolbox is organized as follows: To use models using Models.Models ToolboxManages reference links using the reference dialog. ReferencesManages links a point
reference using the point management dialog. Manage point management levels using the Denive management dialog box. Level 41 Manager. Turn the levels on and off using the level view dialog. View Or modify information about one or more items, such as type, attributes, and
InformationVisualize.Element Dynamic drawing Aids in windows.and Restrict data points.and dynamically display relative distances and angles. AccuDrawActivate switch or disable pop-up settingsAsk/off pop-up keyboard input settings: DIALOG TOOLBOX PRIMARY [OFF] switch 42. MODELSDefinition
of a model when drawing or placing items, in the DGN MicroStation file, is being created a model. The form can be 2D or 3D, and is stored as a separate object within the DGN file. Therefore, each DGN file contains one or more forms, either 2D or 3D. It can be useful to think of an ADGN file as a box
that can contain both 3D and 2D objects, forms, each of which can be viewed independently. When you create a new DGN file from an original file, an empty container configuration is provided with a default model so that you can create a layout. If you use a seed2D file, the default setting will be 2D,
while the 3D seed file is set by default in a 3D configuration. Each model has a set of eight views. The form that views are displayed or are available for viewing at any given time is the active form. There are two types of models: design and paper. Model design: It can be 2D or 3D, and has design
engineering. Paper form — Used to link references to create drawings. Each model has its own unit system. On the contrary, the levels are specific to the DGN file, not a model. Using the form dialog (file &gt;), you can create forms and also quickly switch between forms in the DGN file. If you work with
design models, you can easily create one or more separate models within a single file. Using the forms dialog box, you can quickly switch between forms in the DGN file. Similarly, you can create paper models to create your own design drawings. Drawings usually consist of references to design models.
References can come from the DGNabierto file or from other DGN files on the disk. As with design models, you can use the dialog templates to switch between paper models. At any time, you can view only one active form, either a paper model or a design model. When you create a DGN file, you have a
virtual design model ready for places. When you open the form dialog box, the default form will be named Description as a master model. You can use this model and, if necessary, change its name and describe it to assign more appropriate values. To create a new design model or paper in the file menu,
choose Modelos.Se opens the dialog box. 43. In the form dialog box, click create a new code model. The dialog box opens to create a model. From the list of writing options, choose a design, paper, seed design, or seed sheet. If the type is a layout, choose 2D or 3D from the appropriate options list. The
seed model field displays the initial model name. In the name field, enter the desired name. (Optional) in the description field, enter a brief description of the model. (Optional) Select Create a display group (to create a display group for the form). If you create a display group, you can also change models
using the Group View window. If you're going to need a form as a cell, enable it can be placed as a cell and select a cell type. 44. Click OK. To change the name and/or description of a model in the form dialog, click the edit code for model properties. The dialog shows the characteristics of the model. Edit
the name and description fields as needed. If necessary, enable/disable can be placed as a cell. Click OK. A model reference in many cases, especially in large projects, may be that a design model contains an active model, in addition to one or more references to other models. These references may be
from other forms listed in the open DGN file, or they may be included in other DGN files. If other forms are included as references to the active form, they will still link to the original form. This means that any changes made to the original form will be reflected in the references. If you use references,
multiple designers can work on the same project at the same time. For example, a civilian designer can work on a work model setting up terrain, architect, construction model, mechanical design, on the factory model. Each can rely on other models that indicate their model to be able to survive yet with no
design changes in the rest of the disciplines. When you create forms in a DGN file, you have the option to select a form that can be placed as a cell. When this option is enabled, the model can be indicated as a form, or placed as a cell. When placed as a cell, the link is cut to the original form. To select a
form as a cell1. From the item menu, select Células.Se opens the dialog box to the cell library. 45. 2. From the file menu of the cell library dialog box Vincular.Se open the link cell library dialog box.3 Select the DGN file that contains the desired form (which can be placed in the cell) and click OK. Close the
dialog box and the DGN file will be loaded as a cell library. Forms that can be placed as cells appear in the menu box.4. Select the required forms and click on a position to make them an active cell.5. Use the active cell mode tool to position the form as a cell. To import and copy modelsLearn how to
create form references, you can import a form from another DGN file in an open DGN file. In this case, the link is disconnected to the original model, and the imported form is converted to another model in the open DGN file. Similarly, you can copy an existing form to the open DGN form. To import model
1. In the dialog box, click the model import code. The import dialog is opened file model.2. Use the dialog controls to select the desired DGN file.3. Click OK. The dialog box selects models.4. Select the form to be imported.5. Click OK. To copy form 1. In the forms dialog box, click the model copy code.
The dialog appears as copying model.2. From the list of form options to copy, choose the required form. By default, the model name will appear in the name field, but with an increase (as in Plan-1).3. (Optional) Enter a new name and description.4 Click OK. 46. Delete formsYou can delete any form from
the DGN file except the default form that appears when the DGN file is created. To delete a form from the open DGN file in the form dialog box, select the form to be deleted. Click the form scan icon. The REFERENCESA reference link is a model that is associated with the active model and is
nevertheless displayed in order to be removed by a plotter or as part of a construction process. References cannot be modified. You can link, as a reference, a form that is in an open DGN file or any other DGN file. ToolboxReferences references in the reference toolbox (menu tools &gt;) are used to: link
reference forms to the active form. Control the location, size, and direction of the associated reference model. Unlink reference models from the active layout file. These tools can also be selected as follows: from the tools menu from the reference dialog box (menu &gt; Ref). The dialog controls are also
used to define the reference file settings. On the icons in the dialog references (menu file &gt; reference). To select from the reference toolbox, the form to the active form. Linking referencechanges a cut limit for reference. Set this mask-trimmed trim reference to (cover) part of a model within the cutting
boundaries. 48. Set the reference cutting mask selectively remove one or more masks from the reference. ClippingDefine Plane Reference cleared the back shot of the model3D.Define reference back planeDefine shot of the front shot of the 3D. ReferenceBover reloaded the form. Move the reference
copy form. Copy the reference link 49. Model scale. The Red reference scale is a form. Rotation of a reference measurement of a model based on a horizontal axis. Reference symmetryDefine rendering mode for the model. Select the reference chart to link an active model. Unlink the reference keyboard
entry: DIALOG REFERENCEReferences show reference elements on the screen as if they were in the active form. Although they cannot handle reference elements, the plug-in can be copied even to the active form. The government's ability to provide as much as $100 million to the Government is
needed to provide the most basic health-supported health-support programmes. Engineers and other technical professionals use design combinations to communicate through the visual content of their designs. To create a design configuration using MicroStation, you must create a design model based
on a set of work references used to perform specific engineering tasks. For example, you can link a set of scan points as guides as references to additional geometry mode. Reference links in a layout configuration return to be identical. Linking a reference is the most common way to link a synchronous
reference, which means that the coordinates at the design level of the model referred to, optionally, its universal origin, will align with that active model without applying any rotation, scale, or displacement. To link the reference coincidentntly1. In the file menu, choose the Reference.The dialog references
appears.2. In the tools menu in the dialog box, choose a link.or in the reference dialog, right-click the menu box, and choose a link to Pop-up menu. The dialog appears as a link reference. 51. 3. Check the setting to save a relative path and set it if necessary. If this setting is enabled, the relative path of
the DGN file that contains the model you want to link to will be stored in the link data. It is recommended if you do not expect to change the internal structure of the workspace project component. If not, or if this DGN file belongs to another project or has been shared across several projects, the
recommended Saverelative path setting is off. 4. Select the DGN file that contains the form you want to link to a reference and click OK. The dialog appears to modify the reference link.5. (Optional) from the form options list, select the form you want to link. The default form is the main form of reference.6.
(Optional) (Unless the specified form is already linked) in the logical name field, type a short name to link. 52. 7. (Optional) in the description field of the dialog box, type the description of the model.8. To align the reference with the active model relative to the global asset and design level coordinates,
select Coincident-Environment from the trend list box. This option is only available when you refer to the DGN file form or to align the reference to the design level coordinates only, select match in the Orientation.9 menu box. (Optional) in the scale fields (Main:Ref), select the ratio between the main units
of the active model and the main units of the indicated model. For example: Left RightA is set as the main unit of the active form for each main unit of the indicated (default) model.1 1 5 main units of the active form for each main unit of the indicated form.5 110. (Optional) (DWG work mode only.) Select
the reference level you want to link.11 Select the correct scale checkbox if you want to align active form units to one with units in reference.12. Click OK. Creating links using saved views can be a useful way to set up a drawing for printing. When you complete the drawing, you can only link part of the
model in a reserved view. This process can be automated using the techniques described in creating reference paper forms. To link a reference using a reserved view1. Follow the steps 1 to 7 of the procedure to link a reference in the amatch.2 form. In the direction list box of The calibration link
reference, select the saved view. 53. 3. (Optional) in the scale fields (Main:Ref), select the ratio between the main units of the active model and the main units of the indicated model. For example: to set the left right, a main unit of the active form for each main unit of the indicated form (default).1 1 units of
the active form for each main unit of the indicated form.5 14. (Optional) Select the correct scale checkbox if you want active form units to align one by one with units in reference.5. Click OK. The view area saved for the reference is displayed dynamically as a rectangle centering above the cursor.6. Enter
a data point to place the center of the saved view. To link the active form itself as reference 54. 1. From the file menu, choose the Reference.Reference dialog that will appear.2. In the tools menu in the dialog box, choose a link.or in the reference dialog, right-click the menu box, and choose a link from the
pop-up menu. The dialog appears as a link reference.3. Select the open DGN file, then click OK. The dialog appears to modify the reference link. 55. 4. (Optional) from the form options list, select the active form. The default form is the main form of reference.5. (Optional) (Unless the selected form is
already linked) in the name field, type a short name for the link.6 (Optional) in the description field of the dialog box, type the description of the model.7. Matches the form with yourself, or connects a saved view. 56. RASTER uses MANAGERSet to control the display of one or more bullet-ridding images in
the DGN file view. Work by selecting point management &gt; file from the main menu and selecting a point management tool in the point control toolbox. The dialog is divided into a dot management that you can resize into two sections and a menus bar. The photo list box is included in the top of the
dialog box. You must activate the width of the bottom section by clicking the arrow between the sections. The bottom section of the dialog contains file link information for the selected file (in the menu box). If multiple files are selected, the first file information is displayed in the list. Keyboard entry: DIALOG



RASTERList FrameDismoves file name, and And the logical name for all linked files. Form and status fields can be added to the menu bar using the context menu (appears when you right-click). If there is enough space, the name and path will be displayed. The model field is used to display the source
(design name and model name) from a bullet reference. The status field displays the reference status (loaded, reference, property reference, or point point. If a file is not found, its name will be displayed in red and the message is not found in the Estado.Se you can change the display sequence by
dragging a file to another position in the list. The bullet-image display sequence follows the following rules: 57. • Point images cannot be separated from other images in the design file itself.• Arrange the display of associated bullets through a reference model inherent in this model. Reloadthe indicated
form will update the pattern of the point image display.• Photo groups will be listed in the MicroStation update sequence. Again, images cannot be removed from the active form's image list. • If the model has its own reference, changing the display order of the active form will also change the order of the
images in the model in question. Resizing the dialog includes resizing the menu box, which allows you to view the image file name as necessary. If the number of files in the list exceeds the number of lines displayed, the slider will allow you to scroll through the list. You can select one or more files from
the list. If multiple files are selected, the information provided by the text fields at the bottom of the dialog is applied to the first file in the list. When you double-click a file name, the dialog box shows the link settings. Double-clicking a highlighted file name opens a point context list, which allows you to
perform many of the tasks available in file lists, edit, view, and settings in the point management dialog. Keyboard input: IMGMANAGER Image Selection [número_vista] [nombre_archivo]Keyboard Entry: IMGMANAGER UNSELECT Image [nombre_archivo] pathDismove the entire file specification,
including the directory where a reference was found. SourceDismoves coordinates X, Y, and Z in the lower left corner of the image, in action units. View/height of the display and height of the image in the work units. Dismoves dimensions, color depth, and pixel dimensions of the point image. Pixel size or
FactorW when set to pixel size, displays the size of each pixel in the image, and units work. 58. If it is set to the measurement factor, the scale displays 1:n k and the accuracy in the dpi. GammaDefine displayed the value of gamma correction display. The base value is 1.0. A value of less than 1.0 creates
a darker image and a value greater than 1.0 creates a lighter image. Print gammaDefine gamma correction value for the printer. The pushbuttons allow you to view the view buttons. The color of the dye or the color of the lead color in the color images, the dye color setting is used to add color to the colors
in a dot image. In monochrome images, the foreground color setting controls the color of flat pressure elements. Keyboard inlet: Shaded colored keyboard input: Insert a colored colored tintter keyboard: transparent RGBColor or background color, transparent color setting is used to set a transparent color
to the reference point. When a transparent color setting selected in a dot image is enabled, it becomes transparent. In monochrome images, the background color setting is used to set the background color of the bullet file. In both cases, the selected color is also used as a packing color when cutting
bullets. Keyboard entry: Dot rear keyboard input: Insert the transparent colored keyboard: RASTER TRANSPARENT RGBPrint if enabled, allows the point image to be printed. Unlike if on, the colors of the bullet point image are reversed. It's similar to the negative of a photograph. 59. The specific
transparent color (for color images) or background color (monochrome images) becomes transparent if enabled, so dGN elements or different images can be displayed through the image. Cropfour references to the point that have only been cut. If it is on, a bullet reference will be displayed with a running
snapshot. If you stop, the cropping polygon is ignored and the image is fully displayed. Link &gt; performs the same link tool function in the point control toolbox. Link the dialog to a point reference, which allows you to link bullet files to an open DGN file. Keyboard entry: Fixed keyboard entry attach a fixed
point point: The depositer attach interactive keyboard input: IMGMANAGER openFile &gt; URL link in the dialog box selecting a remote dot image to link the dialog box. Keyboard entry: RASTER URLFile link &gt; unlink selected point references. Keyboard input: DETACH RASTER keyboard input:
IMGMANAGER CLOSEFile &gt; Unlink AllRelinks all point image files. Keyboard entry: DETACHALL Drip Keyboard Entry: IMGMANAGER CLOSEALLFile &gt; Reload editing files with current file data. Keyboard entrance: Reload 60 of the renter. File &gt; AgentRef opens the dialog address agent
reference file. File &gt; Save in the name of... The box opens as a bullet save, which allows you to save the currently selected image in a different format. This item is disabled if multiple image files are selected. Keyboard Entry: IMGMANAGER File Keyboard Keepers Input: RASTER SAVEALL Keyboard
Input: RASTER SAVESFileelected &gt; Project &gt; ImportInbre Import Project Import Dialog Box, which allows you to import a bullet project into the DGN file. File &gt; Convert batch open dialog dialog point conversion, which allows you to convert one or more bullet files into a new format. The same
dialog can also be opened by selecting &gt; image helptools &gt; converting from the main menu MicroStation.Keyboard entry: IMGMANAGER BATCHCONVER file &lt;[file name] &gt;ModifyInforms the same function as the modified tool in the point control tool. Open the image editdia box, which allows
you to adjust the source settings, pixel size or scale, rotation, and convergence for reference. Keyboard input: RASTER TOOLMODIFYE plus &gt; symmetry performs the same functions as a mirror point tool in the Dister control toolbox. The file reflects a point image selected horizontally, vertically, or
diagonally. Additionally, you can locate the axis around which the image is reflected. Keyboard input: RASTER horizontal keyboard input mirror: RASTER vertical mirror &gt; distortions the same functions as the point distortion tool in the Deraster control toolbox. Allows you to adjust the size and
polymorphic shape of a dot image by combining motion, size, rotation, and tilt options. Keyboard entrance: The 1000 AFFINE 61. Keyboard entry: Point HELMERT&gt; AdditionAlforms the same point-cutting tool functions in the DISER control toolbox. Lets you cut a dot image or define a compelling area.
Keyboard input: RASTER CLIP Limits: RASTER CLIP MASKE plus &gt; unscrepped performs the same functions as the point skip tool in the point control toolbox. Delete one or more polygons from pieces from a dot image. Edit &gt; TrimInforms edit the same function as the cutting adjustment tool in the
DISEr control toolbox. Allows you to adjust the polygon pieces graphically. View references &gt; Open References.View &gt; Prepend performs the same function as the Prepend tool in the Display Toolbox, with the Prepend set action. Place the selected images at the front of the display stack. Keyboard
Entry: View IMGMANAGER &lt;Nombre_vista &gt; Put BackRealizes the same function as the deferred tool in the drip view tool with the action set to postpone. Send selected images to the back of the preview stack. Keyboard entry: IMGMANAGER DISPLAY BACKVisualize &gt; ForwardRealizes brings
the same function as the Prepend tool in the Display toolbox, with the action set to one step. The selected image offers one step (up) on the display stack. View &gt; Send BackRealizes the same function as a deferred tool in the dot display toolbox with the procedure set to one step. Send the selected
image one step back (down) in the preview stack. 62. View &gt; Fit the anchor to ViewRealizes the same function as the Fit to View tool in the Display Toolbox, with the mode set to the selected plotter. Adjust the selected images to a view, which is defined by a data point. Keyboard entry: IMGMANAGER
DISPLAY FIT Keyboard Input: RASTER FITVisualize &gt; All ViewRealizes fit the same function as fit to View tool in the Deraster screen toolbox, with set mode to all drips. Adjust all images to a view, which is defined by a data point. Keyboard entry: IMGMANAGER DISPLAY FITALL Keyboard Entry:
FITALLVisualize &gt; Physical Resolution (1:1) displays the image specified in its resolution scale (1:1). A data point determines the central point of the view. It is selected only when you open an image. Performs the same physical precision tool function (1:1) in the visible toolbox &lt;/Nombre_vista&gt;dot,
which allows you to select interactive dot-point to adjust. Keyboard Entry: IMGMANAGER DISPLAY 1FOR1&gt;Link Settings opens the link settings dialog box, which allows you to view link settings and enter corrections to many settings when you deem it necessary. Keyboard Entry: IMGMANAGER
DLGGENERAL Open Keyboard Entry: DIALOG RASTER EDITAjusts &gt; Update Sequence opens the dialogue box update sequence, which allows you to change the order of view in processes related to updating views. Photo &gt; Settings open the dialog box settings for the image server, which allows
you to create new server configuration files and modify existing files. Keyboard input: IMGMANAGER DLGSERVERSETTING open 63. There is a LEVEL SYSTEMLevelA model element at the drawing level. Levels are similar to transparent overlays: in different groups, it's easy to view parts of the form.
You can get an almost unlimited number of levels you want (4 billion) in the DGN file. Setting the active level, the level in which new items are placed in a form, is the active level of the form. The active level is the same for all views. The name of the level that is currently defined as the active level appears
in the attributes toolbox and in the information bar. To define the active level using the active level combo box. In the toolbox attributes click the active level combo box. 64. The combo box opens and the available levels will appear.2 Select the level you want to be active. To set the active level using the
display level dialog1. Click the level view icon in the primary toolbox or in the level submenu of the Settings Menu Select View. The active level.2 appears. Double-click the level that you want to have is the active level. The selected level appears as the active level in toolbox attributes. To select the active
level using keyboard input1. Either the active level is nombre_nivel or LV&lt;nombre_nivel&gt;. To identify the active level using the Manager1 level. In the level submenu of the Settings menu, choose the administrator, or 65. Click the active level field on the information bar. The dialog shows level
management.2. Double-click the level that you want to have is the active level. The level specified as the active level in the list shows a level of Toolbox.Control view level using the level view dialog to activate or &lt;/nombre_nivel&gt;&lt;/nombre_nivel&gt;View the levels in the model according to the
model. To open the display level dialogbox1. Click the level display icon in the primary toolbox.orpress.or in the level submenu of the Settings Menu &lt;CTRL-E&gt;Select the Display.The dialog shows the level display of DGNabierto file levels. 66. To convert the level view of references 1. In the level view
dialog, click the second icon in the second row to enable the view of the goal structure.2. Select references in the goal structure. The required reference levels appear. Note the file and logic columns showing the reference name and the logical name.3. Click the level that is used (i.e., with a point
highlightin the column used) in the open DGN file to turn the level on or off. If the level is enabled, the point will change from white to black. If the level is disabled, the point will change from black to white. To turn the levels view on and off in all views1. Right-click the display buttons and choose to select
all views.2. In the menu box, click one or more levels. You can click levels that contain only items, which are marked by a point in the column used from the level. The selected level will show the status change (on/off) on all views. If the level is enabled, the point will change from white to black. If the level
is deactivated, the point will change from black to white. To turn on and off a one-level view of all views on all models stored in the Open DGN1 file. In the view level dialog, select the public view from the status options list.2. Select the level. The specified level will be displayed to change the status (on/off)
on all views on all models. This action has the same effect as enabling and disabling the global column check mark in the level management dialog box. To turn the level view of all views on all models on and off with the combo box in Active Level1. In the view level dialog, select the public view from the
status options list.2. In the toolbox attributes click the active level combo box. The list of levels appears in the open DGN file.3. Click the check mark next to the level you want to change its width. The selection tag changes to a circle that indicates that the width of the levels is disabled. To &lt;/CTRL-
E&gt;To turn on the screen, click the circle to re-appear the check mark. To change the width of the level graphically1. In the level view dialog, choose the level change tool.2. Define an item that is at the level you want to change its display level.3 Enter a data point anywhere in any view except for an item
to accept the item.4 Under the level change settings, choose View Off from the level options menu to turn off the selected item levels. 67. Orselect unlocks from the level options menu to unlock the selected item levels. Alternative way — to change the width of levels1 graphically. Select or select an item
that is in the levels you want to change its display setting.2 In the level view dialog box, choose a level change tool.3. Continue to step 4 in the main method of this procedure described above (the option specified in the level options list will work on selected or restricted items instead of the selected
item).4. Filters are useful for compiling levels associated with seeing or not displaying them as a group. To turn a set of levels on and off using filters1. In the dialog manage level, click the filter list code. All filters appear in the open DGN file.2. Select the filter to apply. Shows levels that meet filtering
criteria.3 In the menu box, click one or more levels. You can click levels that contain only items, which are marked by a point in the column used from Level 1. Click the level to which you want to move the item. The item is moved to the specified level. Manage the level level manager dialog to create and
delete levels, modify level attributes, and define filters to control the width of level groups according to their attributes. To open the Manager1 level dialog box. Click the active level field on the information bar or in the level submenu of the Settings menu Choose Administrator.Create and delete Levelsto to
create a new level 68. 1. From the list levels of the level manager dialog box, select a new., or click a new level icon. A new level will be created in the list of levels.2 New level name.3. Change any of the other attributes by clicking the appropriate column.4. Click Intro.Se create a new level. Alternative
way — to create a new level1. In the level management dialog box, select the main file that you want to add level.2. Right-click the section level menu.The pop-up menu will appear.3 Select new.4. Fill the name of the new level.5. Click Intro.Se create a new level.6. Change any of the other attributes by
clicking the appropriate column. To copy the levels to a different file1. In the dialog, manage the level, select the level (oniveles) that you want to copy from the level.2 menu. In the Edit menu, choose copy or right-click and select copies of the pop-up menu.3. Open a form in a different DGN file. 69. 4.
Open Level Manager.5. In the categories list, select Model.6. Move the cursor to the list of levels and right-click. A pop-up list.7 appears. In the edit menu, choose Paste, or right-click, and select Paste from the pop-up menu. The level appears in the list of levels. To delete Level 1. In the level management
dialog box, select the level that you want to delete from the level list. Levels can only be deleted in the open DGN file.2. Click on .? On the Edit menu, select Delete., or right-click and select Delete from the pop-up menu. To delete all levels other than 1. In the manager level dialog in the Edit menu, choose
Select All, right-click the levels list and choose Select All, or press &lt;CTRL-A&gt;.2. Click on .? On the Edit menu, select Delete., or right-click and select Delete from the pop-up menu. All uncredited levels will be deleted from the Open DGN file. The levels used will remain unchanged. To clear all levels
that are not used using the keyboard entry, the delete level type is not used. To import levels1. In the list are levels of the level management dialog. This is a standard dialog box selecting the file.2. Click the level library to import. Dgn, dgnlib, or .csv files can be imported. Click OK. Library levels will be
imported to the open DGN file. To export levels1. From the list levels of the level management dialog box select the export level management dialog.Export level library. This is a standard dialog box selecting the file.2. Type the name of the level library you want to export, or select an existing level library
to type over. You can only export dgn, dgnlib or .csv files. .csv
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